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Περίληψη 

Στην παρούσα εργασία στόχος μας είναι ο σχεδιασμός  και η υλοποίηση ενός 

Πληροφοριακού Συστήματος μιας Ακαδημαϊκής Δανειστικής Βιβλιοθήκης.  Αυτό 

επιτυγχάνεται μέσω του προγράμματος Visual Studio 2015  με τις τεχνολογίες 

ASP.NET και C#. Η Βάση Δεδομένων που δημιουργήθηκε είναι τύπου SQL Server 

Database που προσφέρεται μέσα από το Visual Studio 2015, ενώ για την εμφάνιση 

της σελίδας χρησιμοποιήθηκε και το Bootstrap που προσφέρει κάποιες έτοιμες 

κλάσεις CSS, Javascript και γραμματοσειρών. 

Λέξεις κλειδιά: Πληροφοριακό Σύστημα, Ακαδημαϊκή Δανειστική Βιβλιοθήκη, 

ASP.NET, C# 

 

Πανεπιστημιακές Δανειστικές Βιβλιοθήκες 

Οι Ακαδημαϊκές βιβλιοθήκες είναι εκείνες οι βιβλιοθήκες, οι οποίες εξυπηρετούν  τις 

απαιτήσεις ενός εκπαιδευτικού ιδρύματος ανώτατης εκπαίδευσης. Η ακαδημαϊκή 

βιβλιοθήκη βρίσκεται ως επί το πλείστον στους ίδιους χώρους του ανώτατου 

εκπαιδευτικού ιδρύματος που εξυπηρετεί και ο βασικός της στόχος  είναι η παροχή 

επιστημονικού υλικού. Η συλλογή του υλικού αναπτύσσεται, διαμορφώνεται και 

αξιολογείται σύμφωνα με το πρόγραμμα σπουδών του κάθε ιδρύματος στο οποίο 

ανήκει (Καπιδάκης Σ. 2014, σελ. 82). 
 

Ψηφιακές Βιβλιοθήκες 

Για τις ψηφιακές βιβλιοθήκες, έχουν διατυπωθεί αρκετοί ορισμοί την τελευταία 

κυρίως εικοσαετία, όταν και παρουσιάστηκε η μεγάλη ανάπτυξή τους (Καπιδάκης Σ. 

2014, σελ. 82). Αυτό οφείλεται στο γεγονός ότι αποτελούν τομέα έρευνας για πολλές 

διαφορετικές επιστημονικές περιοχές. Μπορεί δηλαδή να θεωρηθεί μια μεγάλη βάση 

δεδομένων για ανάκτηση πληροφοριών (information retrieval), μια εφαρμογή του 

διαδικτύου και για τους βιβλιοθηκονόμους, ένα ακόμη βήμα στην εξέλιξη των 

βιβλιοθηκών.  

Μεταξύ αυτών έχουν χρησιμοποιηθεί οι όροι, Ηλεκτρονική Βιβλιοθήκη και  Εικονική 

βιβλιοθήκη, έχοντας όμως διαφορετική σημασία. Ο όρος Ηλεκτρονική Βιβλιοθήκη, 

δηλώνει ότι η βιβλιοθήκη περιέχει υλικό που για την επισκόπησή του απαιτείται 

ηλεκτρονικός εξοπλισμός, ενώ η νεότερη ονομασία Εικονική Βιβλιοθήκη, δηλώνει 

ότι η βιβλιοθήκη λειτουργεί κατανεμημένα με τη χρήση πρωτοκόλλων που 

διασυνδέονται ψηφιακά, χωρίς να υφίσταται φυσικά (Παπαδημητρόπουλος Π. 2007). 

Είναι χαρακτηριστικό ότι ο Marchionini (2002, σελ.3) λέει ότι «οι Ψ.Β. είναι η λογική 

επέκταση και ανάπτυξη των φυσικών βιβλιοθηκών, στην κοινωνία της ηλεκτρονικής 

πληροφόρησης», ενώ το DLF (Digital Library Federation) αναφέρει ότι σκοπό έχει : 

«την προώθηση της έρευνας, της μάθησης, της κοινωνικής δικαιοσύνης και το 
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δημόσιο συμφέρον, μέσα από το δημιουργικό σχεδιασμό και τη σοφή εφαρμογή των 

τεχνολογιών της ψηφιακής βιβλιοθήκης». 

 

Προηγούμενες εργασίες για Σχεδίαση και Υλοποίηση Διαδικτυακών 

Βιβλιοθηκών 

Στην εργασία της Καραμάνου (2012) το πρόβλημα που πρέπει να λυθεί αφορά τον 

δανεισμό βιβλίων ηλεκτρονικά υπό μορφή ανακοινώσεων. Η λύση του προβλήματος 

προκύπτει με τη χρήση των παρακάτω προγραμμάτων: Apache, Php, PostgreSQL, 

Css. Στην εισήγηση της Παπαδάκη και του Σταμάτιου (2007) μελετάται η ανάπτυξη 

ενός συστήματος διαχείρισης Πανεπιστημιακής Βιβλιοθήκης. Στα παραρτήματα 

αναφέρονται οι απαιτήσεις των δεδομένων που θα πρέπει να υλοποιεί το πρόγραμμα 

της βάσης δεδομένων προκειμένου να υποστηριχθεί η καθημερινή λειτουργία της 

βιβλιοθήκης όσο το δυνατόν αρτιότερα. Στην εργασία του Παπαδανέλλη (2007) 

αναδεικνύεται ο σχεδιασμός και η υλοποίηση μιας διαδικτυακής εφαρμογής 

αυτοματοποίησης όλων των εργασιών μιας κλασσικής δανειστικής βιβλιοθήκης σε 

τεχνολογία ASP .NET, με χρήση γλώσσας C# και βάση δεδομένων Microsoft Access 

με χρήση SQL Server. Στην μελέτη της Ιωαννίδη (2007) βασικό μέλημα είναι ο 

σχεδιασμός και η υλοποίηση μιας εφαρμογής υποστήριξης μιας δανειστικής 

βιβλιοθήκης. Συγκεκριμένα η εφαρμογή έχει αναπτυχθεί σε τεχνολογία VB.NET, με 

βάση δεδομένων σε SQL Server. Τέλος, στην εισήγηση της Μπούσια (2012) σκοπός 

της εργασίας είναι να σχεδιαστεί και να κατασκευαστεί μια δυναμική ιστοσελίδα, που 

θα περιέχει λειτουργίες χρήσιμες τόσο προς έναν χρήστη-μαθητή όσο και προς τον 

διαχειριστή-βιβλιοθηκονόμο με σκοπό την απλοποίηση της καθημερινότητάς τους. 
 

Σχεδίαση Πληροφοριακού Συστήματος μιας Ακαδημαϊκής Δανειστικής 

Βιβλιοθήκης 

Στην παρούσα εργασία σχεδιάστηκε και αναπτύχθηκε ένα πληροφοριακό σύστημα 

μιας ακαδημαϊκής δανειστικής βιβλιοθήκης. Η εφαρμογή αναπτύχθηκε στο 

περιβάλλον Visual Studio 2015 χρησιμοποιώντας τις τεχνολογίες ASP.NET και C# 

σε συνδυασμό με τα ενσωματωμένα εργαλεία που διαθέτει το Visual Studio ώστε να 

επικοινωνεί ομαλά η εφαρμογή με τη βάση δεδομένων SQL που δημιουργήθηκε. Τα 

διαγράμματα UML που παρουσιάζονται στις παρακάτω εικόνες σχεδιάστηκαν στο 

εργαλείο UMLet. 

 

Εικόνα 1 UML Διάγραμμα κλάσεων  

Στην Εικόνα 1 παρουσιάζονται οι κλάσεις της εφαρμογής σε UML διάγραμμα 

κλάσεων. Οι κλάσεις Admin και Loaner κληρονομούν όλες τις ιδιότητες από την 

κλάση User. Ο δανειζόμενος έχει μία επιπλέον ιδιότητα το μέγιστο πλήθος βιβλίων 

που μπορεί να έχει δανειστεί ταυτόχρονα, το οποίο εξαρτάται από το πεδίο Property 

του User. Αν είναι προπτυχιακός φοιτητής μπορεί να δανειστεί μέχρι 5, αν είναι 

μεταπτυχιακός μέχρι 10, αν είναι καθηγητής μέχρι 20. 

Ένας επιπλέον περιορισμός που έχουν οι δανειζόμενοι είναι ότι πρέπει να 

επιστρέψουν μέσα σε ένα μήνα τα βιβλία που δανείζονται, αλλιώς δεν τους 

επιτρέπεται ο δανεισμός. Ο διαχειριστής πράττει όλες τις ενέργειες που τροποποιούν 

τη βάση δεδομένων. Η κλάση Book περιέχει όλες τις πληροφορίες που αφορούν το 

κάθε βιβλίο, ενώ στη κλάση Copies οι πληροφορίες για τα αντίτυπα που υπάρχουν 

στη βιβλιοθήκη για κάθε βιβλίο. Ένα βιβλίο μπορεί να συμμετέχει σε πολλαπλούς 
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δανεισμούς (εφόσον υπάρχουν αρκετά αντίγραφα), ενώ κι ένας δανειζόμενος μπορεί 

να συμμετάσχει σε πολλαπλούς δανεισμούς (έως 5, 10 ή 20). Στη βιβλιοθήκη υπάρχει 

επίσης η κλάση Topics, όπου αποθηκεύονται όλα τα θέματα (π.χ. λογοτεχνία, 

προγραμματισμός κ.α.) της βιβλιοθήκης. Στην κλάση Contents αποθηκεύονται όλοι οι 

συνδυασμοί θεμάτων και βιβλίων.  

 

Ένα βιβλίο μπορεί να αποτελείται από πολλά θέματα, ενώ ένα θέμα μπορεί να 

συναντάται σε πολλά βιβλία. Επιπλέον, υπάρχει η κλάση Writings που καταγράφει τις 

σχέσεις μεταξύ των συγγραφέων που ανήκουν στην κλάση Writer και των βιβλίων. 

Ένας συγγραφέας μπορεί να έχει γράψει πολλά βιβλία κι ένα βιβλίο μπορεί να έχει 

γραφτεί από πολλούς συγγραφείς. Τέλος, υπάρχει η κλάση Publisher στην οποία 

καταγράφονται όλες οι πληροφορίες για τους εκδοτικούς οίκους. Ένας εκδοτικός 

οίκος μπορεί να έχει εκδώσει πολλά βιβλία. 

 

 

Εικόνα 2 UML Διάγραμμα περιπτώσεων χρήσης 

 

Στην Εικόνα 2 παρουσιάζεται το UML διάγραμμα περιπτώσεων χρήσης της 

εφαρμογής. Ο actor Χρήστης μπορεί να κάνει σύνδεση ή εγγραφή στην εφαρμογή. 

Μετά τη σύνδεση, εφόσον ο χρήστης μπορεί είτε να κάνει αναζήτηση (με κριτήριο 

τον τίτλο ή τον συγγραφέα) στα βιβλία που υπάρχουν στη βιβλιοθήκη, να δει όλα τα 

βιβλία που υπάρχουν ή τα διαθέσιμα βιβλία για δανεισμό. Επίσης, μπορεί να δει σε 

μία λίστα τα βιβλία που έχει αυτή τη στιγμή στην κατοχή του. Αν ο χρήστης που 

συνδέθηκε ήταν ο διαχειριστής του συστήματος, τότε μπορεί να κάνει μία σειρά από 
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ενέργειες που είτε τροποποιούν τα περιεχόμενα της βάσης δεδομένων είτε 

προσφέρουν μία γενικότερη εποπτεία. Πιο συγκεκριμένα, μπορεί να δανείσει ή να 

επιστρέψει ένα βιβλίο σε ένα δανειζόμενο. Επίσης, μπορεί να εισάγει ή να διαγράψει 

ένα βιβλίο, έναν εκδοτικό οίκο, ένα συγγραφέα, ένα δανειζόμενο ή ένα θέμα. 

Επιπλέον, έχει τη δυνατότητα να δει σε λίστες όλα τα βιβλία της βιβλιοθήκης, όλα τα 

βιβλία που είναι σε δανεισμό, όλα τα βιβλία που έχουν καθυστερήσει να 

επιστραφούν, όλους τους δανειζόμενους, όλους τους συγγραφείς, όλους τους 

εκδοτικούς οίκους και όλα τα θέματα. 

 

 

 

 

 

Περιγραφή λειτουργικών απαιτήσεων 

Παρακάτω καθορίζονται οι ρόλοι στους οποίους οι χρήστες ομαδοποιούνται και 

επιπλέον καθορίζονται για κάθε ρόλο τα δικαιώματα που έχει στις διάφορες 

λειτουργίες του συστήματος. Αυτό φαίνεται στον παρακάτω πίνακα 1.  

 

Υλοποίηση Διαδικτυακής Δανειστικής Βιβλιοθήκης σε SQL Server με ASP. 

Η εργασία αναπτύχθηκε στο περιβάλλον Visual Studio 2015 με τις τεχνολογίες 

ASP.NET και C#. Η βάση δεδομένων που δημιουργήθηκε είναι τύπου SQL Server 

Database που προσφέρεται μέσα από το Visual Studio 2015, ενώ για την εμφάνιση 

της σελίδας χρησιμοποιήθηκε και το Bootstrap που προσφέρει κάποιες έτοιμες 

κλάσεις CSS, Javascript και γραμματοσειρών. 

Αρχικά δημιουργήσαμε από το Visual Studio επιλέξαμε File->New->Website-

>ASP.NET Web Forms Site. Για να προσθέσουμε τη βάση δεδομένων επιλέξαμε από 

το Visual Studio κάναμε δεξί κλικ στο όνομα του project στο παράθυρο Solution 

Explorer κι επιλέξαμε Add-> Add new item->SQL Server Database. Εκεί 

δημιουργήσαμε τους πίνακες της βάσης δεδομένων σύμφωνα με το πλάνο μας. Στη 

συνέχεια προσθέσαμε 1-1 τα αρχεία που αφορούν τον κώδικα της εφαρμογής μας 
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επιλέγοντας Add-> Add new item -> Web Form (aspx). Στα αρχεία αυτά γράφεται ο 

κώδικας που αφορά την εμφάνιση της σελίδας που βλέπει ο χρήστης. Το Visual 

Studio αυτόματα δημιουργεί και ένα αρχείο τύπου .aspx.cs που αφορά τη λογική πίσω 

από τη σελίδα που βλέπει ο χρήστης. 

Συνολικά δημιουργήσαμε 7 τέτοια ζεύγη αρχείων τα οποία βλέπουμε παρακάτω.  

 
Πίνακας 1 Πίνακας Δικαιωμάτων Χρηστών της εφαρμογής 

ΔΙΚΑΙΩΜΑΤΑ ΧΡΗΣΤΩΝ 

ΡΟΛΟΙ 

Μη 

εγγεγραμένος 

χρήστης 

Εγγεγραμένος 

χρήστης 

(Προπτυχιακός 

Φοιτητής, 

Μεταπτυχιακός 

Φοιτητής, Καθηγητής 

Διαχειριστής 

Λ
ΕΙΤΟ

Υ
Ρ

ΓΙΕΣ
 

Εγγραφή χρήστη   

Σύνδεση στο σύστημα   

Αποσύνδεση από το σύστημα   

Αναζήτηση βιβλίου (με τίτλο, 

συγγραφέα ,θέμα) 
  

Εμφάνιση διαθέσιμων βιβλίων   

Εμφάνιση όλων των βιβλίων   

Δανεισμός βιβλίου   

Επιστροφή βιβλίου   

Εισαγωγή βιβλίου   

Διαγραφή βιβλίου   

Βιβλία σε δανεισμό   

Βιβλία με καθυστέρηση   

Εισαγωγή Συγγραφέα   

Διαγραφή Συγγραφέα   

Εμφάνιση όλων των 

Συγγραφέων 
  

Εισαγωγή Εκδοτικού οίκου   

Διαγραφή Εκδοτικού οίκου   

Εμφάνιση όλων των 

εκδοτικών οίκων 
  

Εισαγωγή θέματος   

Διαγραφή Θέματος   

Εμφάνιση όλων των θεμάτων   

Εμφάνιση όλων των 

δανειζομένων μελών 
  

Διαγραφή  δανειζομένων 

μελών 
  

Εμφάνιση λίστας βιβλίων που 

έχει δανειστεί ο δανειζόμενος 
  
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Πλήρης περιγραφή της ιστοσελίδας με στιγμιότυπα λειτουργιών 

About: Γράφουμε απλά πληροφορίες για την εφαρμογή, σε αυτή την περίπτωση το 

αντίστοιχο αρχείο cs δεν περιέχει κάποια λειτουργία. 

Εικόνα 3: About page 

 

Contact: Πληροφορίες επικοινωνίας. Και σε αυτή την περίπτωση το αρχείο cs δεν 

περιέχει κάποια λειτουργία. 

Εικόνα 4: Contact page 

Login: Ο χρήστης μπορεί να συνδεθεί στην εφαρμογή μέσω αυτής της σελίδας. Το 

αρχείο cs αναλαμβάνει τη σύνδεση με τη βάση και τον έλεγχο αν τα στοιχεία που 

έβαλε ο χρήστης ταιριάζουν με αυτά που υπάρχουν στη βάση. 

Εικόνα 5: Login page 
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Register: Ο χρήστης μπορεί να δημιουργήσει λογαριασμό σε αυτή τη σελίδα. Το 

αρχείο cs αναλαμβάνει να καταχωρήσει το χρήστη στη βάση αν πληρούνται κάποιες 

προϋποθέσεις (π.χ. ο χρήστης καλείται να γράψει δύο φορές το συνθηματικό του, 

οπότε ελέγχει αν ταιριάζουν τα περιεχόμενα των δύο πεδίων). Να σημειωθεί πως το 

λογαριασμό του διαχειριστή τον φτιάχνουμε χειροκίνητα μέσω του Visual Studio για 

να του δώσουμε τα αντίστοιχα δικαιώματα. 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 6: Register page 

 

Home: Η αρχική σελίδα που βλέπει οποιοσδήποτε όταν επισκέπτεται τη σελίδα κι 

έχει τη δυνατότητα να ψάξει για τα βιβλία που υπάρχουν στη βιβλιοθήκη. Το αρχείο 
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cs αναλαμβάνει τη σύνδεση στη βάση, την αναζήτηση αυτών που ζήτησε ο χρήστης 

(π.χ. βάσει τίτλου, συγγραφέα) και να επιστρέψει τα αποτελέσματα. 

 

 

Εικόνα 7: Home page 

 

 

Εικόνα 8: Home page. Αποτελέσματα αναζήτησης με βάση το θέμα 

 

HomeUser: Η σελίδα που βλέπει ο χρήστης μετά τη σύνδεση. Εδώ μπορεί να δει τα 

βιβλία που έχει δανειστεί καθώς και να αναζητήσει βιβλία. Το αρχείο cs αναλαμβάνει 

και πάλι την επιστροφή των κατάλληλων αποτελεσμάτων από τη βάση.  
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Εικόνα 9: HomeUser Page 

 

Admin: Η σελίδα που βλέπει ο διαχειριστής μετά τη σύνδεση του στη σελίδα. Εκεί 

έχει μια πληθώρα επιλογών που αφορούν προσθαφαίρεση στοιχείων στη βάση ή 

επισκόπηση κάποιων στοιχείων. Όλη την επικοινωνία με τη βάση και τα 

αποτελέσματα την αναλαμβάνει και πάλι το αρχείο cs όπου υπάρχει μία συνάρτηση 

που σχετίζεται με κάθε ένα από τα πλήκτρα που μπορεί να πατήσει ο διαχειριστής και 

καλείται για να του επιστρέψει τις πληροφορίες που ζήτησε. 

 

Εικόνα 10 Admin page 
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Εικόνα 11: Admin page. Δανεισμός Βιβλίου 

 

 

Εικόνα 12: Admin page. Επιστροφή Βιβλίου 
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Εικόνα 13: Admin page. Όλα τα βιβλία 

 

Εικόνα 14: Admin page. Εισαγωγή βιβλίου 
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Εικόνα 15 Admin page. Διαγραφή βιβλίου 

Εικόνα 16: Admin page. Βιβλία σε δανεισμό 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 17 Admin page. Βιβλία με καθυστέρηση 
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Εικόνα 18: Admin page. Εισαγωγή Συγγραφέα 

 

 

Εικόνα 19: Admin page. Διαγραφή Συγγραφέα 
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Εικόνα 20: Admin page. Όλοι οι συγγραφείς 

 

 

  

Εικόνα 21: Admin page. Εισαγωγή εκδοτικού οίκου 
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Εικόνα 22: Admin page. Διαγραφή εκδοτικού οίκου 

 

 

Εικόνα 23: Admin page. Όλοι οι εκδοτικοί οίκοι 
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Εικόνα 24: Admin page. Εισαγωγή δανειζομένου 

 

Εικόνα 25: Admin page. Διαγραφή δανειζομένου 
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Εικόνα 26: Admin page. Όλοι οι δανειζόμενοι 

 

Εικόνα 27: Admin page. Εισαγωγή Θέματος 
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Εικόνα 28: Admin page. Διαγραφή Θέματος 

 

 

 

Εικόνα 29:Admin page. Όλα τα θέματα 

 

Συμπεράσματα 

Με τη εξέλιξη της τεχνολογίας και με την πάροδο των χρόνων οι διάφορες υπηρεσίες 

θα εξελίσσονται και αυτές όλο και περισσότερο. Κατά την διάρκεια των 

προηγούμενων χρόνων η ποιότητα του σχεδιασμού των user interfaces των ψηφιακών 

βιβλιοθηκών έχει αυξηθεί σημαντικά. Τα πρότυπα για το γραφικό σχεδιασμό γίνονται 
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κάθε χρόνο και καλύτερα. Μια καλή υποστήριξη για τους χρήστες είναι κάτι 

παραπάνω από μια διακοσμητική διαδικασία. Κομψή σχεδίαση, κατάλληλη 

λειτουργικότητα και συστήματα που ανταποκρίνονται, δημιουργούν μια πολύ μεγάλη 

διαφορά στη δυναμικότητα των ψηφιακών βιβλιοθηκών. Οι ψηφιακές βιβλιοθήκες 

πρέπει να παρέχουν αναζήτηση και συστήματα ανάκτησης ώστε οι χρήστες να 

μπορούν να έχουν εύκολη πλοήγηση στις πληροφορίες. Οι χρήστες πρέπει να νιώθουν 

άνετα και να λαμβάνουν συνεχή πληροφόρηση από το σύστημα με σκοπό την 

ανεύρεση της ζητούμενης πληροφορίας. Μια ψηφιακή βιβλιοθήκη είναι τόσο καλή 

όσο καλό είναι το interface που παρέχει στους χρήστες της. 
 

Στην παρούσα εργασία έγινε προσπάθεια αναβάθμισης του θεσμού της ψηφιακής 

βιβλιοθήκης με την ανάπτυξη μιας εφαρμογής που θα επιτρέπει μια σειρά από 

ενέργειες που θα διευκολύνουν τόσο τον χρήστη, όσο και τα ίδια τα πανεπιστήμια. 

Από την πλευρά του χρήστη η χρήση της βιβλιοθήκης γίνεται πιο εύκολη και πιο 

προσιτή, καθώς θα μπορεί εύκολα να αναζητήσει την βιβλιογραφία που χρειάζεται με 

οποιοδήποτε φίλτρο αναζήτησης τον εξυπηρετεί, όπως συγγραφέα, έτος συγγραφής, 

εκδόσεις ή τίτλο βιβλίου. Επίσης, ο δανειζόμενος μπορεί να ενημερωθεί και για 

κάποια ακόμα διαδικαστικά ζητήματα, όπως το επιτρεπόμενο αριθμό βιβλίων που 

μπορεί να δανειστεί ή την ημερομηνία επιστροφής τους. 

 

Από την άλλη πλευρά, ένα ακαδημαϊκό ίδρυμα έχει την δυνατότητα, μέσω της 

εφαρμογής να διαχειρίζεται με καλύτερο τρόπο τους τίτλους των βιβλίων που έχει 

στη διάθεση της, να τους οργανώνει σε μία βάση δεδομένων, η οποία θα μπορεί να 

ενημερώνεται άμεσα και γρήγορα. Επίσης, θα μπορεί να έχει πλήρη γνώση των 

δανειζόμενων βιβλίων, καθώς και των φοιτητών που καθυστερούν να επιστρέψουν 

αυτά που έχουν δανειστεί. Με αυτό τον τρόπο, θα αποφεύγονται φαινόμενα 

παραβίασης των κανόνων που ορίζουν τις επιστροφές των βιβλίων, αφού θα έχει όλα 

τα στοιχεία των δανειζομένων και σε περιπτώσεις μη ορθής χρήσης θα μπορεί να 

τους αποκλείσει από το σύστημα και να μη τους επιτρέψει μελλοντική πρόσβαση. 
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